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Lab Objective: To gain experience configuring the Cisco UC500, configuring call 
processing, Key System, PBX, Voicemail, Auto Attendant, hunt groups, and additional 

features of the Cisco UC520. 

Please note:  Due to the labs being hosted on remote equipment not all 

components configured within the lab environment can be tested. 

Browser Requirements:  The recommended browser for this lab is Microsoft 
Internet Explorer 6.  If you are accessing Gold Labs (LabOps) with IE7 please 

drop the security level of the browser, add the student URL into the list of trusted 
sites, ensure that pop ups are not being blocked, run the Active X control when 

requested, and run the Telnet Fix offered on the Topology page.  Restart IE7 after 
making these changes.  The labs cannot be accessed via Firefox/Mozilla. 
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LAB TOPOLOGY 
 
 

 
 
 
 

Addressing and Directory Number Assignments 
 

WAN IP Addressing 

WAN IP Address 1.1.100.xx 

WAN Subnet Mask 255.255.255.0 

WAN Default Router 1.1.100.254 

 

Inbound SIP Trunk DID (PSTN Call in) Numbers (Use PSTN phone to test) 
Auto attendant 4085xx1200 

Extension 1 (201) 4085xx1201 

Extension 2 (202) 4085xx1202 

VoiceMail 4085xx1209 

 

Outbound Numbers to Call (From IP Phones on UC520 to PSTN Phone) 

Workstation 4 (CIPC) 

Workstation 3 (CIPC) Workstation 1 (CIPC) 

Workstation 2 (CIPC) 

UC520 UC520 

FXO 0/1/0 to FXS 
0/0/0 

FXS 0/0/0 to FXO 
0/1/0 

Simulated Internet 
& SIP Trunk SP 

Pod 2 Pod1 

 

              79XX          79XX 



Emergency Number 9911 

Local Call 9 777 1000 

Long Distance 9 1 650 7772000 

International 9 011 44 1234512345 

 
For example: 

The value ‘xx’ corresponds to your assigned POD number. 

Pod 1 
IP Address 1.1.100.1 

Auto Attendant 4085011200 

Pod 2 
IP Address 1.1.100.2 

Auto Attendant 4085021200 

LAB OVERVIEW: 
 

Several of the exercises will require partnering with another pod to demonstrate certain 
features of the system.  To complete this, the hardware is pre-wired to your „buddy‟ pod.  

This will emulate a PSTN connection for the lab environment.  Normally, trunks from the 
PSTN are connected into the FXO ports and analog devices (such as a fax machines) are 
connected into the FXS ports.  Please coordinate with the team seated at your „buddy‟ pod 

to ensure that progress of the lab is simultaneously made thereby making it easier to 
complete the verification steps successfully. 

 
All of the software needed to complete the exercises has been installed on the virtual 
workstations. This software includes the Cisco Configuration Assistant (CCA), Cisco IP 

Communicator (CIPC), and the new auto attendant (AA) script. 
 

It will be necessary, unless otherwise noted, to restore the UC500 to factory defaults after 
each exercise.  Instructions on how to do this are included in Appendix A. 
 

Please pay close attention to items highlighted in RED. 

 
This symbol will indicate that the UC520 needs to be reset to factory defaults. 
 

 
Note:  A UC520 system set up as a Key System must be reset to factory defaults 

before being configured as a PBX system and visa versa. 

 



SBCS – Initial Lab Access 
 
Log into the LabOps lab portal and access the Windows XP Workstation 1 or Workstation 3.  Class 

Name information for logging into LabOps is assigned by your instructor. 

Step 1:  Go to the following URL. 

https://labops-out.cisco.com/labops/ilt/default.asp 
 

Step 2:  If you have not done so before you will now need to register with Labops before you can 

use the lab equipment. 

 

Registration includes providing your name and email address to Gold Labs and then clicking save. 

You will get a window saying you have successfully registered. Then you will be able to go in and log 

in using your registered email address and the class name provided by the instructor. 

Step 3:  "Pick" a pod.  Students should choose the pod assigned to them by the instructor.  If you 

pick the same pod as someone else you will be sharing that set of equipment with them. 

 

https://labops-out.cisco.com/labops/ilt/default.asp


 

 

 

Step 4:  You can access your equipment by clicking the "Access" button. 
 

 
Step 5:  A new browser window will open displaying the lab network diagram.  This is an interactive 

portal giving access to each of the Workstations.  You can telnet or RDP to your devices by scrolling 



over the topology and clicking a device. Please access the workstations when instructed to do so in 

the lab guide. Click in the center of Workstation 1‟s screen.  Click in the center of Workstation 3‟s 

screen if working on Pod 2. 

 

 
Note:  
Onsite Live Class - you may have up to 3 lab partners.  Your instructor will assign you to 

either POD 1 or POD 2 within the lab.  Please only access your assigned workstations 

within the POD.  Each POD is configured to reside on it’s own VLan and as such does not 

see the other UC520. 

 

Only one terminal service session may be active per desktop.  If you have a lab partner, 

you will find it easier for one person to access the workstations while the other person 

displays the lab guide on their laptop.  After one or two exercises, you may want to switch 

roles to allow the other person hands on experience. 

 

Online Class – you will not have a lab partner.  You will be configuring POD 1 and POD 2 

within your exercise.  For example, when you have complete Exercise-2 in POD 1, you 

must then complete Exercise-2 in POD 2.  Look for online specific instructions at the 

beginning and end of each individual exercise.   

 

Step 6:  Click on the Terminal Services bar to initiate a remote desktop session to the Windows XP 

Workstation 1 or Workstation 3. 

 



Installing CCA 2.0 
 

Step 1:  Open the my computer icon on the desktop. Click on the NEW(D:) icon in the removable 

storage section and open the folder.  (Make sure this is upgraded for one workstation on each side of 

the pods A and B) 

 
 

Step 2: Click on the Cisco-config-assistant executable.    

 
 

Step 3: The install wizard will appear to guide you through the rest of the process. 

 

 
Step 4: The message “install cannot complete until the previous version is deleted” will appear. Click 

yes to delete the previous version. 

 

 
 

Step 5: Click yes to accept the licensing agreement. 

 

tep 6: Click next to accept the default directory for CCA. 



 
 

Step 7: Click finish to exit the wizard once the installation has completed. 

 

Step 8: Close the CCA 2.0 folder.   

 

LAB SETUP 

 
Setup steps: 

 
Step 1:  Using Appendix A – Reset each UC520 to its default factory configuration using the 

Command Line Interface (CLI) instructions. (Page 68, do not reset CUE.) 

Step 2:  Access Workstation 1 and Workstation 2 in your POD.  If working on POD 2 access 

Workstation 3 and Workstation 4. 

Step 3:  Start IP Communicator on Workstation 1 or Workstation 3. (Online classes start on all 

workstations) 

 



 
 
Step 4:  Start IP Communicator on Workstation 2 or Workstation 4.  (Online classes start on all 

workstations) 

 

 



Step 5:  Once your CIPC‟s have registered (show and extension and the System Message) open the 

Configuration Assistant by clicking on either of the Cisco Configuration Icons on the desktop. 

 

 
 

Step 6: The Cisco music will play and a prompt may appear asking to check for updates to the 

application appear. Leave the default of „no‟ and do not have the system check for updates. Click 

OK. 

 

 

 
 

Step 7: CCA will open with a window to Connect to a UC520 via IP address. This can be a local 

UC520 or a remote customer network. 

 

NOTE: It is possible to create Customer Sites for monitoring customer networks. 

Configurations can be stored in CCA on any workstation.  

 

  



 
 

 

Step 8: Select the Host Name/IP Address tab. 

 

 
 

Step 9:  Enter in the IP address 192.168.10.1.  (The UC520‟s do not see each other and as such use 

this IP address on both Pod 1 and Pod 2.)  This is the default IP Address of the UC520. 

(Step 9a:  If the Security Certificate Alert appears, click always to accept the Security Certificate.) 



 

 
Step 10:  Enter cisco, cisco for the Username and password. 

 

 
 

 
Note: The dialog box from step 7 will appear. The progress for discovery can be seen at 

the bottom left corner of the screen. 

 
 
Step 11: The CCA will attempt to open a Dashboard view of the system information for the UC520.  

In this lab it will cause an error message because the Java on the workstations are not updates. 

Click on the X in the corner of the screen to proceed. 

 

 
 

 



Note: Sample Dashboard Screen: 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 12:  When the screen updates the telephony setup wizard will be available. Close the 

telephony wizard window, in this lab environment the wizard will not be used.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 



 
 

Exercise-1: KEY SYSTEM w/ VOICEMAIL 
 
Introduction: 

The UC520 supports two voice system configuration types – PBX type and Key system type. This 

exercise focuses on the Key System configuration. A typical Key Systems consist of one or more 

lines coming from the PSTN (e.g. Analog FXO trunks) that rings a group of selected phones.  To 

make outbound calls, IP Phone users select one of the buttons on their IP Phones that correspond to 

the lines from the PSTN.  In addition to the PSTN lines, users have internal extensions with 

voicemail. 

 

Objective: 

The main objective of this exercise is to configure the basic Key System with voicemail features. This 

is configured using the Cisco Configuration Assistant (CCA). At the completion of this exercise, the 

system will be configured as a Key System including extensions for all users, voicemail boxes, 

intercom, paging and power failover. 

 

Reference: 

Video Demo for CCA:   http://tools.cisco.com/cmn/jsp/index.jsp?id=61293 

 

Topology: 

 

 
 

NOTE:  Before making any changes in CCA, ensure that the ‘Refresh’ button at the bottom 

of the screen is active. It is grayed out while CCA reads the configuration from the UC520. 

 

Step 1:  Close the Telephony wizard that opened automatically with CCA. Note the menu options 

available with this version from the left menu pain. 

 

Workstation 4 (CIPC) 

UC520 UC520 

FXO 0/1/0 to FXS 
0/0/0 

FXS 0/0/0 to FXO 
0/1/0 

Pod 2 Pod1 

 

              79XX 

Workstation 3 (CIPC) Workstation 1 (CIPC) 

Workstation 2 (CIPC) 

         79XX 

http://tools.cisco.com/cmn/jsp/index.jsp?id=61293


 
 

 
NOTE:  Each Pod’s topology should be similar to the screen shot in Exercise1 step 1 

(above).  The CIPC device will not show in the topology view.  (Where the virtual device is 

plugged in, such as behind an IP Phone or not, the device will or will not be shown in the 

topology view.)   

The Switch shown is the lab Switch being used to simulate the Internet. The IP phones 

will appear in the Telephony configuration menu further in the lab. 

 
Step 2:  Select Configure  Telephony  Region from the menus on the left side. 

Step 3: A message will appear asking for the initialization of the system. For this lab choose Key 

System for the system type. 

 

 

 

 

 

 

 



Step 4: Leave the default of 3 for the Digits per Extension. Enter 298 for the Voicemail Access 

Extension. Click OK 

Step 5: An Initialization box will appear.  

 

 

 

 

 

 

 

Step 6: When the system is ready a pop-up box will appear stating the voice system is initialized. 

Click OK. 

 

 

 

 

 

Step 7: Set the regional information for the UC520 according to the correct switch location. For US 

leave the default information as configured. Click OK. 

 
 

 

NOTE:  Do NOT continue until the Refresh button is available.  If it is grayed out, CCA is 

updating information on the UC520. 
 

 

 

Step 8: Select Configure  Telephony  Voice from the menus on the left or alternatively click the 

Phone icon on the top menu bar. 



 

 

 

Step 9: In the initial System Tab note the hardware that is in the UC520 in the lab. Also note that 

the System settings that were configured initially are stored here. All those options are grayed out 

as they cannot be changed. (To change from Keysystem to PBX requires a reset to factory default.) 

 
 

Step 10:  Change the System Message to „UC520-PODxx‟.  (Where XX is your assigned pod 

number.)  

 

NOTE:  Do NOT continue until the Apply and Refresh buttons are available.  If they are 

grayed out, CCA is updating information on the UC520. 
 

DO NOT CLICK OK or Apply until steps 11 – 15 are completed.   

Note: As system configuration is done color highlighting is used both on the tab label and 

throughout the tab pages.  To indicate if steps were completed correctly (green) 

highlighting is used.  If additional configuration is required or if the configuration is 

incorrect (red) highlighting is used.  The configuration cannot be saved until all items that 

are critical to the system are configured. Once all configuration is correct it can be saved 

to memory. 

 
 

Step 11:  Choose the Voice Features tab. Change the Audio file to the music-on-hold-10db.au 

 



 
 

Step 12:  Set the number of Park Slots to 1.  (Park slots allow phone calls to be placed on hold in a 

location for other users to pick up.) 

Step 13:  Multi-party conferencing can also be enabled here. More attention to this feature will be 

given in the Advanced SBCS lab.  

Step 14:  Select the Users Extensions tab: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

a. For all the Analog Phones (none connected but configured by default on the UC520): 

i. Configure the LastName for all Analog phones as fxs 

ii. Configure the FirstName as a, b, c, d. 

iii. Configure the userid as afxs, bfxs, cfxs, dfxs. 

iv. Set the passwords to 1234. 

b. For the 7960: 

i. Configure the LastName for the phone as ip 

ii. Configure the FirstName as „c‟ 

iii. Configure the userid as cip. 

iv. Set the passwords to 1234. 

c. For the two CIPC Phones: 

i. Configure the LastName for the CIPC phones as „cipc‟ 

ii. Configure the FirstName as „a‟ or „b‟. 

iii. Configure the userid as aip for one and bip for the other. 

iv. Set the passwords to 1234. 

v. Setup Intercom for phone button 2 on AIPC select Intercom to IP phone BIPC from the 

pull down menu. 

vi. Choose button 2 for the intercom location of BIPC. 

 

 

 
 



 
Step 15:  Click on the „Apply‟ button at the bottom of the screen and observe the progress bar.  

 

 

 

 

 

 

Note: If you want to save the CCA configuration you can by clicking on the ‘Save’ icon at 

the top of CCA.               Select All Devices if requested to specify which devices to save.  

 
Verification Steps: 

 
Step 1:  Check the FirstName and LastName on the IP Phones. Place a call from ACIPC to BCIPC, do 

not answer the call and ensure that call rolls over to VM. 

Step 2:  Press the „Messages‟ button on BCIPC and enroll the user in voicemail. Use „789‟ as a 
password.  If pressing the voicemail button results in a fast busy go to the Configure  Telephony  

Voicemail  Mailbox tab and make sure that all the extensions have voicemail enabled.   

 

 
 

Step 3:  Test Intercom by pressing the intercom button on ACIPC  



Step 4:  For the next two steps you need to work with your „partner‟ POD.  (This has already 

been done for you:  Connect an analog cable from FXO port 0/1/0 (on your POD), to the FXS port 

0/0/3 (on the partner‟s POD).  Configure the CFNA timer on the analog FXS ports to 20 seconds.  

Run the test below and then reverse the ports between the two PODs.  

a. From the partner‟s POD call x304– this should ring x201 on your POD. 

 

 
 

 

POD CLEAN UP 
Once this exercise is completed and testing done with the buddy pod, please close 

all instances of CIPC and reset the UC520 and CUE to factory default settings 
using the CLI procedure in Appendix A. 

                                                                                 

Exercise-2: PBX, VOICEMAIL/AUTO ATTENDANT 
 
Introduction: 

The UC520 supports two voice system configuration types – PBX and Key System. This exercise 

focuses on the PBX system configuration. A typical PBX system involves an Auto Attendant that 

handles incoming calls from a PSTN line (e.g. Analog FXO trunks) and transfers the caller to one of 

the internal extensions. Outbound Local, Long Distance, and International calls are routed out 

through a PSTN line. In addition, local extensions have voicemail boxes messages can be left. 

 

Objective: 

The main objective of this exercise is to configure the basic PBX system, voicemail and Auto 

Attendant features. These features will be configured using the Cisco Configuration Assistant (CCA).  

After completion of this exercise, you will be able to setup the SBCS system as a PBX, place calls 

between extensions, and configure a SIP Trunk on the UC520 to a Service Provider (Lab Simulation), 

and place calls in & out to the PSTN via the SIP trunk.   

 

Note:  Due to the virtual nature of this exercise, although you will configure the SIP trunk, 

you will not be able to test the SIP functionality. 

 

Topology: 

 
 
 

 

 

 

 

UC520 

CCA 

PSTN 

SIP Trunk 
Service 
Provider 

WAN 



Setup steps: 

Launch CIPC on both workstations and use the CIPC that displays extension 203 for the remainder of 

this exercise. 

Launch Cisco Configuration Assistant, connect to the created community and enter the username 

and password (cisco/cisco), let it discover the network and connected devices.  

 

Step 1:  Close the error message that is received in this lab re: Adobe flash player. If the Telephony 

Wizard appears, close that as well. Take a moment to identify objects in the Topology view and also 

note the menu options available with this version from the left menu pain. 

 

 
 

 
NOTE:  Each Pod’s topology should be similar to the screen shot in Exercise2 step 18 

(above).  The CIPC device will not show in the topology view.  (Where the virtual device is 

plugged in, such as behind an IP Phone or not, the device will or will not be shown in the 

topology view.)   

The Switch shown is the lab Switch being used to simulate the Internet. The IP phones 

will appear in the Telephony configuration menu further in the lab. 

 
Step 2:  Select Configure  Telephony  Region from the menus on the left side. 

Step 3: A message will appear asking for the initialization of the system. For this lab choose PBX for 

the System Mode. 



Step 4: Leave the default of 3 for the Digits per Extension. Enter 401 for the Voicemail Access 

Extension. Click OK. 

Note: Voicemail can be configured in the Telephony  Voicemail tab as well.  

Step 5: An Initialization box will appear.  

 

 

 

 

 

 

  

Step 6: When the system is ready a pop-up box will appear stating the voice system is initialized. 

Click OK. 

 

 

 

 

 

Step 7: Set the regional information for the UC520 according to the correct switch location. For US 

leave the default information as configured. Click OK. 

 
 

 

NOTE:  Do NOT continue until the Apply and Refresh buttons are available.  If they are 

grayed out, CCA is updating information on the UC520. 
 

 

 



 

Step 8: A window will pop up that the system is updating the UC520 configuration. Wait until the 

system is ready to configure.  

 

 

 

  

 

 

 

Step 9: Select Configure  Telephony  Voice from the menus on the left or alternatively click the 

Phone icon on the top menu bar. 

 

 

 

Step 10: In the initial System Tab note the hardware that is in the UC520 in the lab. Also note that 

the System settings that were configured initially are stored here. All those options are grayed out 

as they cannot be changed. (To change from PBX to Keysystem requires a reset to factory default.)  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

Step 11:  Change the System Message to UC520-PODxx (replace „xx‟ with your pod number).  The 

System Message is displayed on all phones and can be the business name or any other message. 

 

Note: Don’t click on ‘OK’ or ‘Apply’ until all required tabs are configured. 



 

Step 12:  Click on the SIP Trunk tab to configure the UC520 for SIP trunking to a Service Provider 

for PSTN access. 

Step 13:  Select Generic SIP Trunk Provider from the Service Provider pull down menu. 

Step 14:  Set the Registrar Server and Proxy server fields with: 1.1.100.254.  This is the SIP PSTN 

network setup in this exercise. 

Step 15:  Under Digest Authentication set the username to 4085xx1200 and the password to 1234. 

(Where XX is your pod number.) 

Step 16:  Set Maximum Number of Calls to 4. This parameter controls the number of concurrent 

calls supported across the SIP trunk. If the maximum is exceeded, depending on the dial plan 

configuration, the outbound call may be blocked or may rollover to a secondary PSTN trunk.  

 
 
 
Step 17:  Select the Voice Features tab. Choose a different Music on Hold audio file from the drop-

down menu. The UC500 7.0.3 software pack ships with two different music-on-hold files at different 

volume levels. 

 

 

 

 

 

 

 



t 
 
 
 
 
 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 18:  Select 1 for number of Park Slots. The first Park Slot Extension is 701. 

 

Note: Multi-Party (Ad-hoc and Meet me) Conferencing can be configured.  This will be 

explored in more detail in the Advanced Lab. 

 

Step 19:  Click on the User Extensions tab. Configure the users as outlined below. 

a. For all the Analog Phones (none connected but configured by default on the UC520): 

i. Configure the userid as afxs, bfxs, cfxs, dfxs. 

ii. Set the passwords to 1234. 

b. For all the CIPC Phones: 

i. Configure the LastName for all CIPC phones as cipc. 

ii. Configure the FirstName as a, or b. 

iii. Configure the userid as aip, bip. 

iv. Set the passwords to 1234. 

v. Note Call Forward No Answer and Call Forward Busy are set to forward calls to 

401 the configured Voicemail extension. 

vi. Set Permissions to National. Make sure Block restricted number is checked. 

vii. On Button number 2 set the Intercom with mute to user bipc. Set the target 

intercom button number as 2 and click OK. 

c. For the 7960 phone:  

i. Configure the LastName for all the phones as ip. 

ii. Configure the FirstName as c. 

iii. Configure the userid as cip. 



iv. Set the passwords to 1234. 

i. Set Permissions to International.  Ensure Block restricted number is checked. 

 

d. For the BCIPC phone  

 

i. Set Permissions to National. Do not check Block restricted number. 

ii. Verify intercom is configured on button 2 to connect with user aipc. 

 

Step 20:  Click OK at the bottom of the screen. A message will pop up prompting for the company 

main number. Enter 4085XX1201 (where XX is your pod number.) Click OK. 

 

 

 

 

 

 

 

 

Step 21:  Click OK when the „Configuration successfully sent to UC520‟ message box pops up. 

 

 



 

 

 

 

Note: If you want to save the CCA configuration you can by clicking on the ‘Save’ icon at 

the top of CCA.               Select All Devices if requested to specify which devices to save.  

 

System Feature Outbound Call Handling: 

Step 22: Select the Configure  Telephony  Dial Plan  Outgoing menu. Choose the Outgoing Call 

Handling Tab. This will show the entire dial plan for the selected template. Set the numbering plan 

locale to the destination region for the UC520.  

The following are the defaults for North American dialing: 

Numbering Plan Locale  Template: North American 

Default Access Code   9 

Digit Collection Timeout  5 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

Step 23:  Modify the emergency numbers to route to the PSTN only. Select the emergency number 

911, under the trunk priority select PSTN only and click OK. Configure Preference to 1 (the highest.) 

NOTE: By default, if a SIP trunk is configured all outbound calls will be routed to SIP trunk 

first, followed by the PSTN.   

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 24: Select the Caller ID tab. The main caller ID number will be configured (from previous 

configurations) as 4085XX1201 (where XX is your pod number.)  

NOTE: This option allows specifying of the caller ID for outbound calls from the SIP, ISDN, 

BRI and PRI trunks. Note that the caller ID for the FXO trunks is determined by the telco 

service provider and cannot be modified from CCA or the UC500. 

Step 25: For the Caller ID block code use the 916 and click OK.  

 

 

 

 

 

 

 

 

 

 

 

 



Step 26: A message will come up asking to block the restricted number for all users. Click yes. 

 

 

 

  

Step 27: A message will be received that configuration was saved to the UC520. 

Systems feature – Incoming call handling 
CCA can configure the desired call flow for incoming calls. Using this feature incoming calls can be 

directed to a hunt-group, shared line, auto attendant, or any other desired destination. 

 

Step 28:  Click on the Configure button for Incoming Numbers. Select Configure  Telephony  

Dial Plan  Incoming. 

Step 29:  Incoming Call Handling  FXO Trunk Destination is set to Operator. The FXO destination 

can also be set to Auto Attendant pilot once it has been configured. Configure the FXO ports as 

follows:  

FXO port 0/1/0: 401 

FXO port 0/1/1: 275 

FXO port 0/1/2: 501 

FXO port 0/1/3: 203 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 30: Click OK on the FXO port configuration window. A pop-up window verifying that 

configuration has been sent to the UC500 will appear. 

 

This step is greyed out as it cannot be performed in the lab.  

Step 31: Verify the functionality. Use an analog cable to connect the FXO port on the UC500 to the 

FXS port on the next pod‟s UC500 (Increase the CFNA timer on the FXS ports using CCA). 

 

– Calls to the port 0/1/0 should be directed to the Auto Attendant 

– Calls to the port 0/1/1 should be directed to the IP Phones that have shared line 275 

– Calls to the port 0/1/2 should be directed to the 501 hunt-group, unanswered calls are forwarded 

to AA 

– Calls to the port 0/1/3 should be directed to the operator at extension 203 

 



Step 32:  Click on the Dial Plan  Incoming  Direct Dialing Tab.  This feature will be used to add 

the PSTN DID numbers to two of the IP phone users. It may be helpful to maximize this window so 

additional headings are displayed. 

Step 33:  Click on Add in the Direct Dial to User Extension area. 

Step 34:  Click in the Description text box and enter SIPPSTN. 

Step 35:  Enter the starting DID range as 4085xx1201 and ending as 4085xx1202. 

Step 36:  Enter the starting Internal Extension range as 201 and ending as 202.   

Step 37:  Verify that SIP Trunk is selected. Click OK to save the changes. 

Step 38:  Go back to the Dial Plan  Outbound  Caller ID tab and select „Use DID PSTN Number‟ 

for the SIPPSTN trunk  for Caller ID and then click OK.  

 

 

 

 

 

 

 

 

 

 

 

 

By selecting this option, outbound calls from extension 201 will show called ID of 4085xx1201 and 

calls from 202 will show 4085xx1202. Calls from all other extensions will show the main PSTN caller 

ID, configured in step 10. If you select “Use Main PSTN number” for Caller ID, all outbound calls on 

SIP or BRI/PRI trunks will show the main PSTN number as the caller ID 

Hunt group Configuration:  
Hunt groups create a shared line appearance on specified phones that hunts for members of the 

hunt group based on configured parameters. Phones in a hunt group can ring based on a configured 

sequence, based on longest idle time or in a peer fashion. If no member of the hunt group is 

available to take the call, behaviors can be configured for forwarding the call or sending the caller to 

voicemail.   

 

Step 39:  Open the Telephony  Phone Groups  Hunt Groups menu. Enable the first hunt group 

(#501). Leave the hunt group type as sequential. Add all three IP phones to the hunt group.  Select 

„Forward to Voicemail‟ on no answer.  Click OK to save the configuration. 



 
 

Step 40:  Click OK when the „Configuration successfully sent to UC520‟ message box pops up. 

Call Blast Group Configuration:  
Call blast groups are a type of hunt group and as such members of the group share a common line 

appearance on their phones.  When the extension is called ALL members of the blast group will be 

contacted.  If no member of the blast group is available to take the call, behaviors can be configured 

for forwarding the call or sending the caller to voicemail.   

 

Step 41:  Open the Telephony  Phone Groups  Phone Blast Groups menu. Enable the first Blast 

group (extension 511). Add all IP phones to the Blast group. Enter the number „19176645345‟ into 

the other number on the bottom of the screen. Add that number to the members of the blast group. 

On no answer forward calls to the hunt group 501. Click OK to save the configuration. 

 

 

 

 

 

 

 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 42:  Click OK and OK again when the „Configuration successfully sent to UC520‟ message box 

pops up. 

Step 43:  Open the Telephony  Phone Groups  Paging Groups menu. Enable the first paging 

group and give it a description. Add all 3 IP phones to the paging group. Click OK.  

 

 

 

 

 

 

 

 

 

 

 

Step 44:  Click OK when the „Configuration successfully sent to UC520‟ message box pops up. 

Step 45:  Open the Telephony  Phone Groups  Pickup Groups menu. Add the three IP phones as 

members of the first pickup group. Click OK to save the configuration. 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 46:  Click OK when the „Configuration successfully sent to UC520‟ message box pops up. 

Step 47: To configure a system-wide speed dial click on Configure  Telephony  Dial Plan  

System Speed Dial. 

 

Step 48: An error message will appear regarding multiple NICs on the PC. Click Cancel to ignore 

this message. Do not disable either NICs on the workstation. 

 

 
NOTE: If this error message appears again in the lab click Cancel every time. 



Step 49: Click the “Add” button and configure a name and a corresponding number (eg. Cisco 

Support, Number: 918005532447). Remember to include the PBX Access code and the long distance 

prefix for the speed-dial. These parameters are defaulted to 9 and 1 respectively for North American 

dialing and can be changed in the “Dial Plan” tab. Click OK to apply the configuration. 

 

 
 
 

Configuring WAN Connectivity 

 
Step 1: On the menus on the left under Routing select Internet Connections. 

Step 2: In the Internet Connections click on FastEthernet 0/0 

Step 3:  Click on Modify. 

Step 4:  In the Modify Internet Connections window select the Static IP radial button. 

Step 5:  Enter the IP address as 1.1.100.xx („xx‟ POD number - drop any leading 0, only enter 1 for 

POD 01). 

Step 6:  Enter the Subnet mask as 255.255.255.0. 

Step 7:  Enter the Default Gateway and Primary DNS as 1.1.100.254.  

Step 8:  Click OK twice to apply changes. 

 



 
 
 

 

Verification Steps: 
 

Step 1:  On the IP Phones ensure the First Name and the Last Name is visible. 

Step 2:  Dial the voicemail access number (401) or press the Messages key         on each phone 

and enroll the users. Use 789 as the password.  

Note: you will not be able to record a greeting, simply use the default blank greeting. 

 
If pressing the voicemail button results in a fast busy go to the Configure  Telephony  Voicemail 

 Mailbox tab (see figure on page 21) and make sure that all the extensions have voicemail 

enabled.   

 

Step 3:  Place calls between IP Phones and ensure that calls roll over to VM when not answered.  

Step 4:  Check that the MWI light turns on when a message is left and check messages. (Messages 

cannot be left because of the issue with the microphones and drivers.) 

Step 5: OPTIONAL: Press “Services” key on the IP Phone and select the “CME Services URL” to 

launch Voice View Express (VVE). Use the password 789 from step 3 for PIN.  
VoiceView Express (VVE) and IMAP exercises are outlined in Appendix B.  
 

Step 6:  From any phone, press “Directory” key and then select the “Local Speed Dial” option 

(option 5). Verify that the system-wide speed-dial configured in the system tab appears here. 

 



 
 

 

Test the Call Park and Pickup feature 

Step 1:  Dial extension aipc from extension bipc. 

Step 2:  Answer the call on extension aipc. 

Step 3:  Click the More softkey and then click the Park softkey.  The call will be placed in the Parked 

area and music on hold will be audible. 

Step 4:  Click the Pickup softkey from extension aipc, dial 701 and the call will resume.  Ideally the 

call would be picked up from another extension, however, due to the limited number of phones in 

this exercise extension 203 is used to test this functionality.   

Test the Paging feature 

Step 1:  From one of the CIPC phones, dial 101. 

Step 2:  View the other CIPC phone and notice that the IP Communicator is off hook.  Initially IP 

Paging1 will display on the screen. 

Test the Intercom feature 

Step 1:  From ACIPC press the intercom to verify that intercom to line BCIPC works. 

Test the hunt-group functionality 

Step 1:  From any extension dial extension 501 (the hunt-group pilot number). 

Step 2:  If configured correctly, the call will attempt to call AIP, if no answer, BIP, and then CIP and 

finally it will go to voicemail. 

Test the blast-group functionality 

Step 1:  From any extension dial 511 (the blast group pilot number).  

Step 2:  If configured correctly, the call will ring all extensions and if not answered roll-over to 501. 

 

 



 
Note: It is NOT necessary to reset the system at the end of this exercise. 

 

Exercise-3: Business Schedule and Auto Attendant 
 
Introduction: 

The UC520 supports Automated Attendant (AA) that can provide flexible call handling. CCA release 

1.9 supports an advanced AA system that can meet the need of a typical Small Business. This AA 

supports a Business Schedule and a Holiday Schedule that enables intelligent time-of-the-day 

routing. The new enhanced capability includes a multi-menu system and also allows a provision to 

have multiple Auto Attendant scripts that can be triggered by different incoming DIDs. Finally, the 

system provides an easy interface for recording AA greetings and helps set up a Greetings 

Management System that can be used by the end customers to alter the greetings from their IP 

Phones. 

 

 

Objective: 

The main objective of this lab is to configure a fully functional Auto Attendant system. The lab will 

focus on a multi-menu AA system which integrates itself with a Business Schedule and a Holiday 

Schedule. Students will also experience the ease of recording a greeting and the process of setting 

up a Greetings Management System. 

 

 

Prerequisite: 

This lab requires a basic PBX system to be already in place 

 

 

 

Topology: 

 
 
Setup steps: 

 
Step 1:  Launch Cisco Configuration Assistant (CCA) on your laptop. Please make sure that a 

basic PBX system is already setup 

 

Step 2:  From the left menus, click on Configure > Telephony > Schedules 
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Step 3:  Configure the system schedule. Make sure to check the box for Enable Business 

Schedule. 

 

Step 4: Make sure that you are modifying the systemschedule and from the pull-down select 

Uncheck boxes from 00:00 to 09:00 for weekdays (this will mark 12am to 9am as closed hours 

on weekdays). You can also use the widget to uncheck all the boxes for a specific day/time. 

 

Step 5:  Click on Update Table. Once, the table is updated, Uncheck boxes from 17:00 to 24:00 

for weekdays (this will mark 5pm to 12am as closed hours on weekday). 

 

 
 

Step 6:  Next, Uncheck boxes from 00:00 to 24:00 for weekends – this will mark the weekends 

as closed 

 

Step 7:  The above steps will set your Business Hours from Monday to Friday 9am to 5pm. 

 



 
 

Step 8:  Setup the holiday schedule as per the requirement. For this, click on the Holiday tab and on 

Holiday Management select 2009 holidays. 

 

Step 9:  Next, click on the Add button at the bottom of the Holiday Management tab. This will 

launch as Add Holiday window. In this window, make sure that the year is set to 2009. 



 
 

 

Step 10:  Specify „Independence Day‟ in the description of the holiday that is being added then click 

on the Date Picker icon. This will Launch a Date Picker window.  

 

Step 11:  Set the date to July 3. Using these steps all holidays observed by the company can be 

added to the schedule. Click on OK to apply the changes. Now the system schedule is set. 

 



 
 

Step 12:  Proceed with the configuration of the Auto Attendant. Click on Configure  Telephony  

Auto Attendant. This will launch the AA multilevel node window.  

 

Step 13:  Click on the Multi-Level mode. 

 



 
 
Step 14:  On the Multi-Level Auto Attendant, select the number of submenus as 2. This will create 

two additional Submenu tabs. 

 

 

Step 15:  Configure the parameters for the Main menu. Configure the AA Extension to be 400. The 

AA PSTN number will be 4085xx1200 (where xx is the 2-digit POD #) 

 

Step 16:  For the Business Hour Schedule make sure that system schedule is selected from the pull-

down menu. 

 

Step 17:  Check the Dial by Number Anytime parameter. 

 

Note:  Due to VMware restrictions you will not be able to record greetings. The next 

step is therefore greyed out. 



 

Step 18: Click on the “Record” button and record the following greeting: 

i. The main open greetings, which says “Thank you for calling, if you know your 

party‟s extension you can enter it at any time. For dial-by-name directory hit 7. 

If you have a mailbox on this system press 9. For Sales press 1 for Customer 

Support press2. For directions to our location press 8. To repeat these options 

press *, or press 0 to reach an operator. 

ii. A greetings to record directions to your facility 

iii. An opening greetings for Sales department 

iv. An opening greetings for the Customer Support department 

 

 
 

Step 19:  Configure the main menu Business Hours. Select the Menu Prompt as 

AABusinessOpen.wav. 

 

Step 20:  For Keys 0-9,# and *, select the following values corresponding to modes and 

parameters from the pull-down menus. 

 

0 Call Extension  203 (CIP) 

1 Call Menu  Submenu 1 

2 Call Menu  Submenu 2 

7 Dial By Name 

8 Play Prompt  AAWelome.wav 

9 Call Voicemail 

* Play Prompt  AABusinessOpen.wav 

 



 
 

Step 21:  Click on the Submenu1 sub-tab. For this, from the pull-down menu, select the Prompt 

AAWelcome.wav.  

 

Step 22:  For Keys 0-9,# and *, select the following values corresponding to modes and 

parameters from the pull-down menus. 

 

0 Call Extension  203 (CIP) 

1 Call Hunt Group Hunt Group:1(501) 

* Call Menu  Main menu (to skip and go back to the main menu) 

 



 
 

Step 23:  Next Click on the Submenu2 sub-tab. For this, from the pull-down menu, select the 

Prompt AASPlayExtensions.wav.  

 

Step 24:  For Keys 0-9,# and *, select the following values corresponding to modes and parameters 

from the pull-down menus. 

 

 0 Call Extension  203 (Operator) 

 1 Call Hunt Group Hunt Group:1(501) 

 * Call Menu  Main menu (to skip and go back to the main menu) 

 



 
 

Step 25: Once you have completed this exercise click on the “Apply” button to commit these 

changes. 

 

Step 26: To allow end customers to make changes to the recorded greetings, setup a Greetings 

Management System. Click on the Prompt Management tab. 

 

Step 27:  Select an extension (for example 409), that is not in use, that will be dialed to interact 

with the Greetings Management system.  

 

Step 28:  Next assign administrators that are authorized to change the greetings. For this, click on 

the Prompt Administrators button – this will launch an “Assign Prompt Management Privilege” 

window. 

 

Step 29:  On this window, select user aip as authorized users to alter pre-recorded greetings. Once 

finished, click on OK button on this window and Apply button on the Prompt Management tab. 

 

 

 

Step 30:  CCA 1.9 also allows uploading custom auto-attendant scripts.  



 

 
 

Note: that this is an advanced exercise for partners that have expertise in creating custom 

scripts – this is an optional section of the lab for those who need to know how to setup 

custom scripts using CCA 

 

Step 31:  Once you have created a script that meets your customer‟s needs, save it on your laptop. 

Click on the Add button and browse to the location of the script. Once added, the script appears 

along with the other system scripts. 

 



 
 

 



Verify steps: 

 

Step 1:  Call in using SIP trunk to the 4085xx1200 number (where xx is the 2-digit POD #). 

Make sure that the call is answered by the Auto Attendant 

 

Step 2:  There should be silence because there is no ability to record in this lab. 

 

Step 3:  Browse through the different options of the Auto Attendant and make sure all menu 

options are working as expected. 

 

Step 4:  Press 0 to reach the operator. 

 

Step 5:  Reach the appropriate submenu by dialing option 1 or 2 

 

Step 6:  Pressing 9 should transfer to the voicemail. Try to hear the other greeting options (8                                  

and *)   

 

Step 7:  Verify the correct greetings from the Sub-menus, get transferred to the appropriate 

hunt-group, and are able to fallback to the main menu using the * key 

 

Step 8: See if an authorized user is able to access the Greeting Management System.  

 

Exercise-4: ADVANCED FEATURE EXERCISE 

 

This exercise will focus on configuring some advanced features using CCA, CME/CUE GUI, and CLI. 

Features configured in this exercise include but are not limited to: 

 

Phone features - Monitor buttons, Overlays, Shared DNs, Speed-dial, CFW from a non-primary 

line. 

System features - Local Directory, DNs w/ multiple Hunt-groups, Forwarding from hunt-groups. 

Phone features – Monitor buttons 
 
Step 1:  Launch the Configure  Telephony  Voice configuration page on CCA. 

Step 2:  Select the User Extensions tab.  

Step 3:  Select the phone „bip‟. This user‟s phone will be treated as operator‟s phone. 

Step 4:  On button 3, select the type as Monitor. 

Step 5:  From the extension pull-down select 201. 

Step 6:  On button 4, select the type as Monitor. 

Step 7:  From the extension pull-down select 203. 

Step 8:  Click on OK. 

Step 9:  Click on OK at the bottom of the Voice configuration page and apply the changes. 

Step 10:  Verify the monitor buttons and functionality. Place 201 or 203 off hook, this should 

indicate a busy presence status on the respective monitor button.  

 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 11:  Press the monitor button while the monitored line is idle, this should speed dial the 

extension that it is being monitored. 

Step 12: Transfer a call from 201 to 202 by answering the incoming call, pressing the Trnsfer 

softkey and pressing the third button on the phone. Then press the Trnsfr softkey again. 

 
 

Phone features – Shared DNs 

In this section, extension 275 will be configured as a shared line between bip and cip. 

 
Step 1:  Launch the Voice configuration page on CCA. 

Step 2:  Select the Users tab.  

Step 3:  Click on the more option for bip. 

Step 4:  On the More Options set the button 6 type as share. 



 

 

 

 

 

 

 

 

 

 

 

Step 5:  Select extension 275 in the Extension column. 

Step 6:  Click OK. 

Step 7:  Now select cip. 

Step 8:  Set the button 5 type as share. 

Step 9:  Select extension 275 in the Extension(s) column. 

Step 10:  Click OK. 

Step 11:  Click OK at the bottom of the Voice configuration page. 

Step 12:  Once the changes are applied, check both IP Phones for ext 275.  

Step 13:  Verify the functionality by making a call to 275 and ensure that both IP Phones ring. 

Step 14: Answer the call on bip. When the shared line is in use by another phone, the LED turns red 

 

Step 15: On the phone labeled bip, place a call. When the shared line is in on hold by another 

phone, the LED blinks red.  

 

Step 16:  On cip, press button 4 (ext 275) to resume the call. When the shared line is picked up, 

the LED turns solid green. 

 

   

Phone features – Multi line appearance 
The ability to have more than one phone number (or „line‟) appear on a phone for answering 

purposes or visual indication of line in use. 

 

Step 1:  Launch the Configure  Telephony  Voice menu in CCA. 

Step 2:  Select the Users tab. 

Step 3:  Select the more option for aip.  

Step 4:  On button 3, select the type as Normal and specify the extension as 251. 

Step 5:  On button 4, select the type as Normal and specify the extension as 252. 

 

 

 



 

 

 

 

 

 

Step 6:  Click on OK. 

Step 7:  Select the Users tab. 

Step 8:  Select the more option for cip.  

Step 9:  On button 3, select the type as Normal and specify the extension as 261. 

Step 10:  On button 4, select the type as Normal and specify the extension as 262. 

Step 11:  Click on OK. 

Step 12:  Click on OK at the bottom of the Voice configuration page. 

Step 13:  Once the changes are applied, verify the IP Phones display the additional lines.  Place calls 

to ensure the additional lines are functional. 

 
Phone features – Overlay DNs 

Overlay DNs are used in scenarios where a single button can be used to answer calls to multiple 

numbers. This is typically true for lower end phones that have fewer buttons. Follow the steps below 

to configure the operator‟s phone with overlay for extensions 261 and 262.  
 
Step 1:  Launch the Voice configuration page on CCA. 

Step 2:  Select the Users tab.  

Step 3:  Select the more option for bip. This is the operator phone for this exercise. 

Step 4:  For button 5 select the type as Overlay. 

Step 5:  Select Overlay under the Extension(s) column. 

Step 6:  In the next window Overlay - bip, add extensions 261 and 262. 

Step 7:  Use 261 for the Overlay button label. Click on OK 

Step 8:  Click OK again on the More Options window. 

Step 9:  Click on OK at the bottom of the Voice configuration page. 

Step 10:  Once the changes are applied, check bip‟s IP Phone and ensure that an overlay button is 

created. The overlay line label will display the first extension from the overlay group. 

Step 11:  Verify the overlay functionality by making calls to 261, and 262 and ensure that this 

overlay line rings.  

 

 

 

 

 



 

 

 

 

 

 

 

 

 

 

 
 

 
 

 
Phone features – Label for buttons 
Labels default to the phone number associated with the button. The Label cannot be 

changed for Monitored lines all others can be changed. Changing the label on a shared line 
will change the label for all phones sharing the line.  

 
Step 1:  Launch the Voice configuration page on CCA. 

Step 2:  Select the Users tab.  

Step 3:  Click on the more option for cip. 

Step 4:  On button 3, extension 261 configure the label as 261_SecondLine.  

Step 4:  On button 4, extension 262 configure the label as 262_ThirdLine.  

 

 

 

 

 

 

 

 

 

 

Step 5:  Click on ok to save the configuration.  

 

Step 6:  Verify the functionality – check the IP Communicator for the appropriate display of labels.  

 



 
 

Phone features – Speed dials 

CCA supports global speed dial configuration.  Users can configure personal speed dials by going to 

the CME user web GUI or they can be configured for the user by the Administrator. (The CUE GUI 

can also be used to create speed dials on a phone.) 

 

Step 1:  Launch a web-browser and browse to the URL http://192.168.10.1/ccme.html. 

Step 2:  Use the credentials configured in the Users tab. For example, for phone 202, use 

username/password as bip/1234. 

Step 3:  Click on Configure  Phone 

Step 4:  Scroll down to the Speed dial section and configure 97771000 for speedial1. 

Step 5:  Scroll down to the bottom of the screen and click on Save change. 

   
 
 
 

http://192.168.10.1/ccme.html


            
 
Phone features: Using the CUE GUI 
Follow the steps below to configure this using CME/CUE GUI. 

 

Step 1:  From workstation 1 or Workstation 3, access CUE via a web browser using the following 

URL http://10.1.10.1. 

Step 2:  The Username is „cisco‟ and password is „cisco‟. 

 

 

 

 

 

 

 

 

 

Step 3:  Select from the menus Configure  Phones. 

 

 

 

 

 

 

 

 

 

 

 

 
Step 4:  Speed dials can be configured here as well.  

 

http://10.1.10.1/


System feature – Local directory 

To create directory entries, CLI will be used for the following section. 

 
Step 1:  For CLI access open a telnet session to UC520 at 192.168.10.1. 

Step 2:  Login with the username cisco and password cisco. 

Step 3:  Enter the enable mode by typing in „enable’ at the router prompt.  Use the enable 

password of cisco. 

Step 4:  To configure the directory entries enter configuration mode by typing in „config t‟ once in 

the enable mode. 

Step 5:  Enter the telephony-service mode by typing „telephony-service‟ at the config prompt. 

Step 6:  Enter the local directory entries for the TME‟s phones as indicated below. 

directory entry 1 914085256963 name Joseph’s Phone 

directory entry 2 914085257827 name Zeecil's Phone 

directory entry 3 914085274236 name Farshids's Phone 

 
Step 7:  Type „end‟ once completed to exit out of the configuration mode. 

 
 
Using one of the IP Communicator phones to check the directory entries. 

Step 1:  Press the „Directories‟ button 

Step 2:  Select option 4 for Local Directory.  This can be done by either pressing the 4 on the 

number key pad or by using the scroll buttons and then pressing the Select softkey button. 

Step 3:  In the Directory Search, enter „Phone‟ for LastName.  All three entries that were created 

above should be displayed in the list. 

   
 



 

Changing Phone Settings - Ring Tone and Background  
 

Step 1:  On the CIPC on workstation 1 press the Settings button. Go to User Settings. 

Step 2:  Select Ring and change the ring tone.  Save. 

Step 3:  Select Background, choose a new background for the phone and Select. Save the new 

background.  

 

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Pod Clean Up 
After completing the verification steps above RESTORE the system to factory 
default using the CLI as shown in Appendix A. 

 

 
 
 
 
 
 
 

 

 

 

  
 



Exercise 5- SECURITY & WIRELESS 
 

Introduction: 

The UC520 is a part of the SBCS (Smart Business Communications System) family of products.  In 

addition to its role as an IP phone system, it will also provide Wireless, VPN and Security services. 

  

Objective: 

The main objective of this exercise is to configure the basic Wireless and Security features. These 

features will be configured using Cisco Configuration Assistant (CCA). At the end of this exercise, a 

user should be able to configure a WiFi IP phone and also configure VPN access for remote 

teleworkers to access the internet. 

 

Topology: 

 
Setup Steps: 

 

Step 1:  Open CCA and login. 

Step 2:  Select from within the Configure Tab on the left side Security  Firewall and DMZ. 

Step 3:  Change the firewall setting from Low to Medium to High. Notice the description changes as 

you move the bar.  Change the setting back to Low. Leave the remaining settings in their default 

configuration.  

Step 4:  Click OK to close the screen. 
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Step 5:  From the Security menu on the left select NAT. 

Step 6:  In the NAT window select Add then in the window choose Web Server as the Type of 

Service.  This sets NAT for HTTP traffic. 

Step 7:  Set the Private IP Address to 192.168.10.100.  (This is a simulated web server address.) 

Step 8:  Set both the Original Port and Translated port to 80. 

Step 9:  Click OK. 

 



 
 

Step 10:  Again under Security select VPN Server. 

Step 11:  Create a EZVPN account by clicking on the Add button on the right side of the screen.  

Use the following criteria for the account. 

Username cisco123 

Password cisco123 

Preshared key cisco123 

Starting IP Address 192.168.10.101 

Ending IP Address 192.168.10.110 

DNS Primary IP 192.168.10.111 

 

Step 12:  Click OK. 



 

 
 

 

Verification Steps 

This section is for reference only.  As the equipment resides in a remote location, connecting a 

laptop to the unit is not possible in this scenario. 

 

Connect a laptop to the available „broadband internet‟ connection at your pod.  Verify that an IP 

address in the 1.1.100.1xx range is obtained.  Using a VPN client, create a profile for the UC520 and 

see if you can open a VPN connection to it. 

Create a new connection and set the following parameters: 

Host 1.1.100.xx (xx is your POD# - drop the leading 0 if any) 

Name EZVPN_GROUP_1 

Password cisco123 

If the connection is successfully established, an IP address in the 192.168.10.x network is obtained.  

Launch CCA at this time.  This emulates the method that would be used to provide remote support 

to a customer system. 
 
Running a Security Audit 



Running the security audit allows the administrator to quickly determine whether or not changes 

need to be made to the UC520‟s configuration to better secure it against possible problems. 

 
Step 1:  Select from the Security Audit from the security menu. 

Step 2:  In the Security Audit window click the Security Audit 

button. 

Note that it may take several minutes to get a response 

from the audit. 

 
 
When the audit completes, it will display a list of potential 

security problems that may need attention such as is seen in the 

following screen shot.  To complete any of the recommendations 

simply click on the check box in the Fix column and click OK at 

the bottom of the screen.  In this scenario two 

recommendations will be fixed. 

 

 
 
Step 1:  Check Disable IP Source route. 

Step 2:  Check the Enabled password encryption. 

Step 3:  Click OK. 



Configuring Wireless 

The equipment used in this lab does not have the wireless component and as such cannot be 

configured.  These steps are included for reference purposes only.  Please review the steps required 

to configure the wireless component on the UC520 and the 7921G Wireless IP Phone. 

 

This section shows how to configure the wireless settings on the UC520 and how to configure a 

7921G IP Phone with SSID podxx (where xx is the pod #). 

 

Step 1:  From the menus on the left select Configure  Wireless  WLANs 

 
 

 

Step 2:  Click on the UC520-Voice entry and delete it. Click on Create to add a new entry.  Make the 

SSID “podxx” (xx is your POD #).  This will be the same SSID used to configure the 7921. 

 

Step 2:  We recommend the use of WPA2-PSK on the UC520 for the voice SSID –modify. Select the 

below: 

Security WPA2-PSK 

Pre-Shared Key  cisco123   

 

Step 3:  Click on OK.  Make note of the generated SSID, as this will be required to configure the 

7921 phone. 

 

Step 4:  Click on the UC520-Data SSID and delete it. 

Step 5:  Click on Create and add an SSID of “podxx-data” on Vlan 1.   

 



Step 6:  Again we recommend the use of WPA2-PSK on the UC520 for the data SSID. Select the 

below options: 

Security  WPA2-PSK 

Pre-Shared Key “12345678”   

 

Step 7:  Click on “OK” to download the updated configuration to UC520. 

 

On the 7921 

This portion of the lab is for reference only as the lab is in a remote setting and cannot 

communicate with a 7921 nor is a 7921 available. 

 

Step 1:  Power on the 7921. 

Step 2:  Using the down arrow key browse to the Settings menu. 

Step 3:  Select Network Profiles and press „**#‟.  This will unlock the configuration on the phone. 

Step 4:  From the menus select to Add a new profile. 

Step 5:  Select Change. 

Step 6:  Add a profile name called UC520-xx (xx is your POD #). 

Step 7:  From the menus browse to WLAN configuration. 

Step 8:  Add the SSID „podxx‟ created earlier. 

Step 9:  Set the Security Mode to Auto (AKM). 

Step 10:  Set the Key Style to ASCII. 

Step 11:  Set the Pre-Shared key to the key used earlier (cisco123).  Do this using the phone key 

pad. 

Step 12:  Select Options and select Save. 

Step 13:  Navigate back to the Main Screen. 

The 7921 should now register to the UC520 and receive an auto assigned extension. 

 
Verification Steps 
 
Place test calls to/from the wireless phone to verify correct operation. 

 

 

 

Pod Clean Up 
NOTE: When this exercise is complete on both buddy pods, please reset the UC520 

to factory default setting using the procedure in Appendix A. 
 
 

  



APPENDIX A: Reset to factory default 
There are two methods that can be used to restore the system to factory defaults.  The first is to use 

the GUI and the second is to telnet to the UC520 and then use the Command Line Interface (CLI). 

 

GUI 
 

Step 1:  From the menus on the left click on Maintenance  Restart/Reset. 

Step 2:  Check the box Reset to Factory Default. 

Step 3:  Click Apply. 

 
 

Step 4:  A Restart/Reset window will appear with an option to Archive the configuration. Skip this 

for now and click on “Yes” to continue with the reset. 
 

 
 
 

Please wait 10 minutes for this to complete. 

 

 
 



CLI 
 
Alternatively CLI can be used to reset the system to factory default.    Resetting to factory defaults 

via the CLI is a two part process.  CUE needs to be reset separate from CME.  The reason for this is 

that the CUE component, written in Linux, is a separate system from CME.  Follow the steps outlined 

below. 

 

Establish a telnet session 

Step 1:  Click Start  Run. 

Step 2:  In the Run window type cmd to open a command window. 

Step 3:  At the prompt type telnet 192.168.10.1  Alternatively connect a laptop to a POE port on 

the UC520 and telnet to 192.168.10.1.  

Step 4:  At the User Access Verification username prompt enter cisco. 

Step 5:  At the password prompt enter cisco. 

To Reset CME 

 

To reset CME back to factory defaults ensure the config file UC520-8U-4FXO-K9-factory.cfg is in 

flash.  Once confirmed this file will need to be copied to the start-up config essentially over 

writing any configuration that is in ROM memory.  Using the following commands: 

 

Step 1:  At the router prompt type dir flash: (with the colon). 

Step 2:  Verify the file name listed below and then copy the UC520 config file to the start up 

configuration using this exact command: 

    copy flash:UC520-8U-4FXO-K9-factory-7.0.3.cfg  startup-config 

(If the filename is different substitute the filename in this command for the correct name.) 

Step 3:  At the Destination filename [startup-config]? prompt press Enter to confirm. 

Step 4:  Once the file is copied, type “reload” to restart the UC520. You may see „system 

configuration has been modified. Save?‟ Type ‘n’   

Step 5:  Confirm the reload by pressing Enter. 

 
The telnet connection drops once the reload is initiated.  When the UC520 has finished 

rebooting it will be in the factory default mode.  This can take up to 10 minutes. 

 

Step 6:  To check to see if the UC520 is back online try re-establishing the telnet connection.  

If dithe login prompt is presented, the unit is back online. 

Step 7:  Once the prompt is presented close the command window. 

 

To Reset CUE 

 

Step 1:  Session into CUE by typing the command „service-module Integrated-Service-

Engine 0/0 session’.  (Hit „enter‟ twice to get a prompt). 

Step 2:  Type „offline‟ to go into the offline mode. 



Step 3:  Type in „y’ when you are prompted with „Are you sure you want to go offline[n]?‟ 

Step 4:  Type in „restore factory default’ 

Step 5:  Type in ‘y‟ when you are prompted with „Do you wish to continue[n]?‟ 

Step 6:  Press the Enter key when prompted to „Press any key to reload:‟ 

This reset can take 5-10 minutes.  Wait until the CUE message „SYSTEM ONLINE‟ is displayed before 

proceeding. 

 

APPENDIX B: Verifying VoiceView Express & IMAP 
 
VoiceView Express 

 

VoiceView Express (VVE) allows a user to manage their voicemail box via the display on their IP 

Phone.  The following steps outline how a user logs in and then views header information for each 

voicemail in their account. 

Step 1:  On the phone press the Services button. 

Step 2:  From the menus displayed scroll down to the CME Service URL.  Alternately the number 

displayed next to the menu can also be depressed to select that menu. 

Step 3:  Use the password 789 which was created during an earlier enrollment process. 

Step 4:  Follow the menu prompts on the IP Phone display to listen to and manage voicemail. 

 

ii.     

 
 
 

IMAP Integration 
 

Formatted: Bullets and Numbering



IMAP Integration allows the user to use an IMAP client such as Outlook Express to manage voicemail 

on the CUE system.  The following steps outline how to set up a new IMAP account using Outlook 

Express to view messages on the voicemail system.  

 

Step 1:  From workstation 1 or Workstation 3 launch the Outlook Express. 
Step 2:  From the menus at the top select Tools  Accounts. 

Step 3:  Click Add. 

Step 4:  Select Mail. 

Step 5:  Configure a display name.  In the lab use „aip Voicemail‟. 

Step 6:  Click Next. 

Step 7:  In the email address field use username@10.1.10.1. Replace username with „aip‟. 

Step 8:  Click Next. 

Step 9:  On the Email Server setting, select the incoming mail server as an IMAP server.  

Step 10:  For incoming and outgoing server, configure 10.1.10.1. 

Step 11:  Click Next. 

Step 12:  Enter the Account Name as „aip‟ and the Password as „1234‟. 

Step 13:  Click Next. 

     

   
 

mailto:username@10.1.10.1


       

 
 



 
 

 

 

 

 

 

 

 
 



 

APPENDIX C: Configuring Security on the Cisco 
UC500 and SR500 
 
Introduction: 

The Cisco SR500 provided asymmetric digital subscriber line (ADSL) or FastEthernet WAN 

termination and advanced security features for a Cisco Smart Business Communications System 

(SBCS) network. This document describes how to connect a Cisco UC500 behind a Cisco SR500 in 

secure router mode.  

 

Objective: 

Configure the initial SR500 and UC500 setup for connectivity. Network address translation (NAT) is 

not required on the UC500 in this configuration, because the SR500 manages NAT for the network. 

 

 
 
Connect your Cisco UC500 to a Windows PC, as shown  

 

Note: Before proceeding, RESTORE the system to factory default as shown in Appendix A 

 



Configuring the Cisco UC500 

 

To configure the Cisco UC500 using CCA, do the following: 

 

Step 1:  Enter the Cisco UC500 LAN IP address in the Connect to field on the Connect window. 

 

Step 2:  Enter your Cisco UC500 administrator username and password. 

 
Step 3:  Go to Configure  Security  NAT. 

 

Step 4:  From the Outside Interface menu on the NAT window, select Delete Interface. 

 

Step 5:  Click Apply to disable NAT on the UC500. (The Cisco SR500 will NAT incoming and outgoing 

Internet traffic; the Cisco UC500 does not require that NAT is enabled.) 

 

 
 
Step 6:  Go to Configure  Security  Firewall and DMZ. 

 



 
 
Step 7:  Click Delete Firewall Settings. 

 
Step 8:  Click Yes to clear the warning message. This deletes the firewall settings from Cisco UC500. 

A firewall is not required on Cisco UC500, because the Cisco SR500 provides a firewall for the 

network. 

 
Step 9:  Go to Setup  Device Setup Wizard. 

 

Step 10:  Select UC500 from the menu and click Next. 

 

Step 11:  Click Next until device connectivity is verified. It might take 2-3 minutes to verify the 

device connectivity. Click Next 

 



 
 
Step 12:  Enter your UC500 administrator username and password. The default username is cisco. 

The default password is cisco. Click Next. 

 

 
 

 
 



Step 13:  Verify that the Synchronize with PC checkbox is checked. This synchronizes the time and 

date settings on the UC500 with your PC and click Next. 

 

 
 
Step 14:  Select Fastethernet0/0 and click Modify. 

 



 
 
Step 15:  Choose Static IP. 

 

Step 16:  In the Internet IP Address field, enter 192.168.75.2. 

 

Step 17:  Enter the Primary DNS IP address and the Secondary DNS IP address that match the DNS 

server IP addresses used in your network and click OK. Then click Next. 



 
 

 
 

Step 18:  Select your language from the Phone Language menu, and voicemail language. 

 
Step 19:  Select your language Voicemail Language menu click next. 

 



 
 
Step 20:  Verify your settings. To make any changes, click Previous; otherwise, click Finish. 

 
Step 21:  Click Yes when the warning displays. 

 
 
Note If you retained the VLAN 1 IP address of 192.168.10.1, Cisco Configuration Assistant does not 

lose connectivity to the Cisco UC500 and applies the configuration settings to the Cisco UC500. This 

process can take 8-10 minutes 



Once the process is complete, you should see the following message. 

 

 
 

Step 22:  Click Close to exit the setup wizard. 

 
Step 23:  Go to Configure  Save Configuration and click Save. 

 

Connect your Cisco UC500, Cisco SR500, and Windows PC as shown  

 
 
Your Internet/WAN connection might be an ADSL or an Ethernet connection, depending on the Cisco 

SR500 chassis type. 

 



Step 1:  Enter the SR500 LAN IP address in the Connect to field in Cisco Configuration Assistant. 

 

 
 
If your connection is rejected, it might be necessary to manually release and renew your DHCP lease 

to obtain an IP address from the Cisco SR500, by doing the following: 

 
a. To open a Run window, select Start > Run 

 

b. Enter CMD in the Open field to launch a Windows Command window. 

 

c. Enter ipconfig /release at the Windows command prompt. 

 

d. Enter ipconfig /renew at the Windows command prompt. You should get an IP address that 

is in the 192.168.75.xxx network.  

 

For example: 

C:\temp>ipconfig /renew 

Windows IP Configuration 

Ethernet adapter Local Area Connection: 

Connection-specific DNS Suffix . : cisco.com 

IP Address. . . . . . . . . . . . : 192.168.75.11 

Subnet Mask . . . . . . . . . . . : 255.255.255.0 

Default Gateway . . . . . . . . . : 192.168.75.1 

 



Step 2:  Go to Setup > Device Setup Wizard. 

 

 
 
Step 3:  From the Select a device menu, select SR500 and click Next. 

 

Step 4:  Click Next until device connectivity is verified. It might take 2-3 minutes to verify the 

device connectivity. 

 

Step 5:  Enter your Cisco SR500 administrator username and password. The default username is 

admin. The default password is admin. 

 

Step 6:  Verify that the Synchronize with PC checkbox is checked. This synchronizes the time and 

date settings on the UC500 with your PC and click Next. 

 

Step 7A:  If you are using WAN FastEthernet, the following window displays: 



 
 

Step 8A:  Select Fastethernet4 and click Edit. 

 
Step 7B:  If you are using ADSL, the following window displays: 

 



 
Step 8B:  Select ATM0.1 and click Edit. 

 
Step 9:  Specify your Cisco SR500 Internet connection settings and click OK. These settings vary 

depending on which provider and what WAN type you are using to connect to the Internet. For 

example: 

 

DHCP with FastEthernet: 

 
  



PPPoE with FastEthernet: 

 

 
 
The username and password should match the account information provided by your Internet 

service provider. 

 

PPPoE with ADSL: 

 

The username and password should match the account information provided by your Internet 

service provider. 

 



Step 10:  Click Next. Verify your settings. To make any changes, click Previous; otherwise click 

Finish. After 1-2 minutes, the Summary message displays. Click Close. 

 

 
 
The configuration of the Cisco SR500 is complete. 



Creating a Community 

 
To create a community that includes both the Cisco UC500 and the Cisco SR500, do the following: 

 

Step 1:  Start Configuration Assistant, and select Create community in the Connect window. Click 

Connect. 

 

Step 2:  In the Create Community window, enter a name for the community. 

 

 
 
Step 3: Enter the Cisco SR500 IP address in the Seed IP Address field. Click Start. 

 

Step 4: When prompted, enter the Cisco UC500 and the Cisco SR500 administrator usernames and 

passwords. Click OK. 

 

Step 5: In Topology view, verify that the Cisco UC500 is connected behind the Cisco SR500. 

 



 
 
Step 6:  Go to Configure > Save Configuration. 

 

Step 7:  Select All Devices in the Hostname menu. Click Save. 

 

 
 

The configuration is complete. 

 
You can now connect your Cisco Configuration Assistant PC to any LAN port on the Cisco UC500 or 

Cisco SR500 to access the community you created, allowing you to monitor the network and modify 

the device configurations. 



 
You should connect all LAN devices, such as PCs, IP phones, printers, switches, and access points, to 

the Cisco UC500 LAN ports to access the WAN or the Internet from the LAN devices. LAN devices 

connected to the UC500 have secure access to the WAN and the Internet, because they are 

protected by the security features you enabled on the Cisco SR500. 

 

You might choose to connect DMZ devices, such as Web servers or email servers, to the Cisco 

SR500. 

 

 



Configuring NAT on the SR520 

 

Step 1: Go to Configure  Security  NAT 

 

Step 2: Some default translations exist, but to add another, click the Add button. 

 

Step 3: Choose a server type from the Type of Service menu 

 

Step 4: In the Private IP address field, enter the IP address the server uses on the internal network. 

 

Step 5: In the Original Port field, enter a port number for the inside device. This is the port number 

used by the server to accept service request from the internal network. 

 

Step 6: In the Translated Port field, enter a port number that NAT is to use for the translation. This 

is the port used by the server to accept service request from the Internet. 

 
Step 7: Click OK to save and close the window. 

 

 
 
Enabling VPN Remote and Server Settings on the SR520 

Consult the FirstLook Lab 8A section. The directions on the UC500 and SR520 are the same. 

 

Enabling the Firewall on the SR520 

 
Step 1: Go to Configure  Security  Security Audit  Firewall and DMZ 

 

Step 2: Select the Hostname of the SR520. 

 

Step 3: From the Outside Zone menu, select the Outside (untrusted) interface 

 

Step 4: From the Inside Zone menu, select the Inside (trusted) interface 

 



Step 5: Select a Low, Medium, or High security level. Medium and High security settings require 

DNS IP addresses. 

 

Step 6: Click Apply to enable the firewall on the SR520 

 

 
 

Enabling a DMZ on the SR520 

 

Step 1: Select the DMZ tab 

 

Step 2: Typically you will want to create a new VLAN before doing this step. If you select an outside 

or inside interface already identified with the firewall, a warning dialog appears.  

 



 
 

Step 3: Click Create and use the Create DMZ Service window. 

 



 
 

Enabling IPS on the SR520 

 
Step 1: Go to ConfigureSecurity  Security Audit  IPS 

 

Step 2: Select the Hostname of the SR520. 

 

Step 3: From the Outside Interfaces menu, select the Outside interface 

 

Step 4: From the Inside Interfaces menu, select the Inside  interface. If you have a wireless SR520, 

the wireless LAN will also show up and can be selected.  

 

Step 5: Click the “Click here to get the public key” link.  Log in if prompted. Paste the key into the 

Public Key field. 

 



 



Step 6: Click the Install SDF button.  If you do not yet have the sdf package, click the “Click here to 

download latest SDM-IPS sdf package”.  Log in if prompted. Download the package to your 

computer, click browse and select the package, then click the OK button. 

 

 
 



Step 7:  The signatures will be installed 

 

 
 



Step 8: IPS Signature Updates are uploaded on the IPS Signature Update tab. 

 

 
 



Any traffic matching IPS signatures will be displayed on the IPS Alert tab. 

 

 
 



Enabling SSL VPN on the SR520 

 

Note: A static IP address on the WAN interface is required for SSL VPN. Basic SSL VPN configuration 

only enables clientless browsing of a secure intranet. See the advanced tab for additional options. 

 
Step 1: Go to Configure  Security  Security Audit  SSL VPN 

 

Step 2: Select the Hostname of the SR520. 

 

Step 3: Add a new user account for the SSL VPN connection. 

 

 



Step 4: To add an Intranet Website to be displayed in the SSL VPN portal page, click Add, and use 

the Intranet Websites Add URL window. 

 

Advanced Options 

 

There are three SSL VPN modes.  

 Default - The default mode is the clientless mode allowing secure access to private web 

content. 

 Thin Client - Enabling the Thin Client extends the default capability by allowing remote access 

to TCP-based application static ports. 

 Full Tunnel - Full tunnel mode provides a lightweight SSL VPN tunneling client for network 

layer access to virtually any application. 

It is recommended that the SSL VPN Client be added to the router so that it can be downloaded by 

clients.  

Finally, enabling the Cisco Secure Desktop is recommended for optimal security. Enabling this allows 

CSD to write session data in an encrypted format to a special vault area of the client‟s disk. This is 

removed at the end of the VPN session. Only a machine with Cisco Secure Desktop installed can 

establish an SSL VPN connection when this box is checked.  

 

 
 



Enabling URL Filtering on the SR520 

 

Step 1: Go to Configure  Security  Security Audit  URL Filtering 

 

Step 2: Select the Hostname of the SR520. 

 

Step 3: Select “Enable URL Filtering” 

 

Step 4: This example has allowed all domains except the one manually entered into the Deny 

Domain List box. 

 

 
 

Enabling Wireless on the SR520 

 

Consult the FirstLook Lab 7B section. The directions on the UC500 and SR520 are the same. 



 

APPENDIX D: Prompt Management 
 

Prompt management is completed using one of two methods.  The Windows Sound Recorder can be 

utilized or alternatively by using the Prompt Management system on Cisco Unity Express. 

 

Note:  Due to the virtual nature of this lab sound, which is required when using the 

Window Sound Recorder, cannot be recorded.  The Sound Recorder steps have been 

included for your reference.  Please proceed to USING PROMPT MANAGEMENT. 

 

The following steps outline how to use the Windows Sound Recorder utility to record prompts for the 

Auto Attendant.  

 

Step 1:  Open the Windows Sound Recorder by selecting Start  Programs  Accessories  

Entertainment   Sound Recorder. 

Step 2:  Click the Red Record button to start recording 

Step 3:  After the prompts are recorded, click on File  Properties and change the Audio format as 

outlined in the screen shot below. 

Step 4:  In the Format Conversion section, click on Convert Now. 

Step 5:  In the Sound Selection window scroll up and select CCITT u-law. 

Step 6:  Click OK. 

Step 7:  Ensure that the Audio Format in the Properties page reflects CCITT u-law, 8Khz, 8 Bit, 

Mono. 

 
 



 
Using CUE for Prompt Management 
 

Using CUE for prompt management requires the use of the CUE Web GUI and some CLI commands. 

The following configuration steps are divided into 3 main sections. 

 

Section A configures a Call-in number for the prompt-management script, 

Section B assigns admin rights to a specific extension, and  

Section C provides guidance of the CLI configuration on the UC520. 

 

 

SECTION A 

Configuring the Call-in number or trigger for the prompt management script. 

 

Step 1:  Launch a web browser on the student desktop and go to http://10.1.10.1. 

Step 2:  Login using the administrator username cisco and password cisco. 

 

 
 
 

Step 3: Click on Administration  Call-in Numbers 

Step 4: Click on Add 

 

       
 
Step 5:  In the Add a call-in Number window select promptmgmt from the Application drop down 

list. 

Step 6:  Configure the „Call-in Number‟ as 402 

Step 7:  Click on Add. Close the Add a Call in Number window. 

http://10.1.10.1/


 
Step 8:  Ensure that the new call-in number appears under Administrator  Call-in Numbers. 

      
 

SECTION B  

Assignment of administrator rights to extension 201. 

 

Step 1:  Click on Configure  Users 

 

  
 

Step 2:  Click on the username aip. A User Profile window displays with the parameters for user A 

IP‟s account. 

Step 3:  Set the PIN to 789. 

Step 4:  Click Apply.  Do not close the Parameter window. 

   
 

Step 5:  Click on the Groups tab, notice that the list contains IMAPgrp. 

Step 6:  Click on Subscribe as member. 

Step 7:  Type in Administrator for the Group ID. 



 
Step 8:  Click Find.  

    
 
 
Step 9:  Select the Group ID Administrators 

Step 10:  Click on Select row(s). 

Step 11:  Ensure aip shows as a member of the administrator group. 

Step 12:  Close the User Profile window. 

    
 
SECTION C 

Step 13:  Telnet to the UC520 IP Address of 192.168.10.1 using MS-DOS or cmd window.  The 

username is cisco and password is cisco. 

Step 14:  Enter enable mode by typing „en‟ (short for enable) at the router prompt if it does not 

show a # symbol. 

Step 15:  Use the following CLI to add a dial-peer for prompt-management.  This can be cut and 

pasted or typed one line at a time.  The „config t‟ (or configuration terminal) command puts the 

router into configuration mode. 

config t 

dial-peer voice 2010 voip 

description dial-peer for prompt management 

destination-pattern 402 

b2bua 

session protocol sipv2 

session target ipv4:10.1.10.1 

dtmf-relay sip-notify 

codec g711ulaw 

no vad 

end 



 

 
Note:  The following recording of a prompt steps are for reference only and cannot be 

completed in this exercise due to the lack of recording capability in the remote pods.  

Please review this step and then proceed to step 21. 

 
Step 16:  Go off-hook on any phone and dial 402 to trigger the prompt-management script. 

Step 17:  The script will prompt for an extension/pin (followed by #). Use extension 201 and pin 

789.  

Step 18:  Select option 2 to Administer Custom Prompt. 

Step 19:  Press 1 to record a new prompt. 

Step 20:  After recording the prompt, press 1 to save the prompt before terminating the call. 

The prompts recorded are in the format: 

 

 
 

If you recorded a prompt using the Windows Sound Recorder tool click on the Browse button next to 

the menu prompt to upload the prompt. 

 



 

 
 

If the prompt was recorded using Prompt Management, then first refresh the voice window. This can 

be done by either clicking on the refresh icon on top left corner or by closing and re-launching the 

voice window. Once the window is refreshed, select the prompt from the Menu Prompt drop down 

menu. 

APPENDIX E: PPPoE on the WAN 
 

Introduction: 

PPPoE can also be configured on the WAN interface of the UC520. One example of this WAN 

deployment would be to connect the WAN interface though Ethernet to a DSL modem.  The DSL 

modem would be connected to a Service Provider.  The PPPoE configuration would then have to 

reside either on the DSL modem or can also be configured on the UC520. 

 

Objective: 

In this exercise, PPPoE will be configured on the UC520 on the WAN interface using CCA. Understand 

the pre-requisite steps needed to enable PPPoE on the WAN interface. 

 

Exercise Set-up: 

Refer to the main diagram. 

 

Setup Steps: 

Step 1:  Launch CCA and login with the username „cisco‟ and password „cisco‟. 

Step 2:  Let it discover the network and connected devices. 

Step 3: Click on Configure  Routing  Internet Connection 

 

Step 4: Select WAN Interface FastEthernet 0/0 and click on modify 

 
 



 

  
Step 5: Check PPPoE button, enter username, password and select DHCP. Click OK 

 

Step 6: Click Apply and then OK on the Internet Connection screen 

 
Step 7: Click on Configure  Security  NAT 

 

Step 8: Delete NAT settings and click OK 

 

Step 9: Select Dialer0/FastEthernet0/0 as the outside Interface and click Apply and then OK 

 
Verification Steps: 

 

Step 1:  Telnet into the UC520 from workstation 1 or workstation 3. 

Step 2:  Check if the Dialer0 interface is UP/UP using the „show ip interface brief‟ command from the 

UC520# prompt. 

 



 

APPENDIX F: Configuring IPSEC VPNs between 

sites on the UC520 

 
This Appendix builds on Exercise-8 which covered inter site dialing.  To configure the underlying 

IPSEC VPNs between sites please refer to the below link: 

 

IPSEC with QoS: 

http://www.cisco.com/en/US/products/ps6635/products_white_paper09186a0080189080.shtml  

 

A sample config for EVEN POD (POD 2) to ODD POD (POD 1) is shown below 

 

NOTE: The WAN IP for EVEN POD is 1.1.100.12 and for ODD POD is 1.1.100.11 
 
! 

crypto isakmp policy 1 

authentication pre-share 

group 2 

crypto isakmp key sbcs address 1.1.100.11 

! 

! 

crypto ipsec transform-set vpn-test esp-3des esp-sha-hmac 

! 

! 

crypto map vpn 6 ipsec-isakmp 

set peer 1.1.100.11 

set transform-set vpn-test 

match address 199 

! 

! 

! 

interface FastEthernet0/0 

ip address 1.1.100.12 255.255.255.0 

crypto map vpn 

! 

! 

! 

access-list 199 permit ip 10.1.1.0 255.255.255.0 any 

access-list 199 permit ip 1.1.100.12 255.255.255.0 any 

 
 

 

 

 

 

 

 

 

 

http://www.cisco.com/en/US/products/ps6635/products_white_paper09186a0080189080.shtml


 

APPENDIX G: IOS Dial-Peer Configuration 
 

 
Introduction: 

This appendix goes over a feature in the UC520 software (IOS) called dial peers which are the core 

for routing calls out the IP network (VoIP) or TDM interfaces (POTS) such as FXO, T1 / E1 PRI on the 

UC520. Essentially the dial-peers in the configuration define the dial plan for calls going through the 

UC520. The appendix will introduce this concept of dial-peers and some basics. 

 

NOTE: In general, dialplan customization should be done through the CCA. This is section 

is intended only as a reference to users who have a high degree of IOS and CLI 

experience. If IOS CLI must be used, please make sure to follow the Out-of-Band 

Configuration Guidelines posted below: 

  

Reference: 

 

Cisco Configuration Assistant 1.9 Out of Band Configuration Guidelines 

http://www.cisco.com/en/US/docs/net_mgmt/cisco_configuration_assistant/version1_9/out_of_band

_reference/cca_oob_config_guidelines.pdf 

 

http://www.cisco.com/en/US/tech/tk652/tk90/technologies_tech_note09186a0080147524.shtml  

 

http://www.cisco.com/en/US/products/sw/iosswrel/ps1835/products_configuration_guide_chapter09

186a0080080aec.html  

 

Objective: 

The default configuration on the UC520 as well as Cisco Configuration Assistant (CCA) does leverage 

dial-peers for a lot of the call routing / dial plan functionality. The objective is to show what the dial-

peer CLI pushed down means to a certain extent. It will also go over a couple of examples of using 

dial-peers such as for least cost routing or translating digit strings. All configurations will be done 

using the command line interface (CLI).  After completion of this lab – you should have a simplistic 

overview of dialplan and call routing in UC520 / SBCS.  

 

http://www.cisco.com/en/US/docs/net_mgmt/cisco_configuration_assistant/version1_9/out_of_band_reference/cca_oob_config_guidelines.pdf
http://www.cisco.com/en/US/docs/net_mgmt/cisco_configuration_assistant/version1_9/out_of_band_reference/cca_oob_config_guidelines.pdf
http://www.cisco.com/en/US/tech/tk652/tk90/technologies_tech_note09186a0080147524.shtml
http://www.cisco.com/en/US/products/sw/iosswrel/ps1835/products_configuration_guide_chapter09186a0080080aec.html
http://www.cisco.com/en/US/products/sw/iosswrel/ps1835/products_configuration_guide_chapter09186a0080080aec.html


 
Overview: 

o Types of Dial Peers 

A dial peer is essentially a route to a particular destination. Dial peers establish logical connections, 

or call legs, to complete an end-to-end call. Cisco voice-enabled routers support five types of voice 

dial peers but two types are of greater significance for SBCS: 

 

Step 1: POTS dial peers: Used for traditional telephony network (TDM) including FXO, FXS, BRI, T1 

/ E1 PRI etc. Below is an example of how a POTS dial peer is used to route calls starting with 9 + 7 

digits i.e. a Local call in North America. Also, using [2-9] implies that the 2nd digit dial will be 

between the range of 2 to 9 and the remaining 6 digits can be anything from 0 to 9. 

 
dial-peer voice 5000 pots 
destination-pattern 9[2-9]…… 
port 0/1/0 
  
 
 
 
 
 
 
 
 
 

 
 

PSTN FXO 

UC520 



 
Step 2:  VoIP dial peers: Used for routing calls over the IP network to an IP address or DNS 

hostname. The 2 main VoIP protocols used are H.323 (default) or SIP (recommended). Typical 

examples for uses of VoIP dial-peers in UC520 are to route calls to voicemail / AA (via CUE), route 

calls over a SIP trunk to a provider or inter site dialing (as shown in Lab #8B). Below is an example 

of a dial-peer on the Odd pod to route calls to the even pod using 82xxx. 

 
dial-peer voice 5100 voip 
destination-pattern 82… 
session protocol sipv2 Using SIP as VOIP protocol 
codec g711ulaw  Using G711 as the VOIP codec 
session target ipv4:10.10.10.2  Defines IP address to send VOIP call to 
no vad 
dtmf-relay rtp-nte 
 
 

 
 

UC520 UC520 

IP Network 

Even POD Odd POD 



 
Outbound Dial-peer matching patterns 

Dial-peers route on the value after the destination-pattern CLI under each dial-peer. Common 

destination pattern wildcards are  

 

Pattern Explanation 

Digits such as 0-9,*,# Digits one would dial on a phone 

Period or dot (.)  Specifies any one wildcard digit 

Comma (,)  Inserts a one-second pause 

Square brackets [x-y] Indicates a range of digits within the brackets 

Percentage (%) The preceding digit occurred zero or more times 

T  Indicates a variable-length pattern 

 

For the North American dial-plan, here is a typical example of what you would have 
Local 7-digit dialing  destination-pattern 9[2-9]...... 

Long Distance 11-digit “1+” dialing  destination-pattern 91[2-9]..[2-9]...... 

International dialing  destination-pattern 9011T 

Emergency or 911  destination-pattern 9911 

 

 

Here is another exercise showing how dial-peer matching occurs based on the below config: 

 
 



 
Least Cost routing 

Outbound dial-peer matching is primarily based on the called-number matching the destination-

pattern as shown above. However in case the destination-pattern is EXACTLY the same, then the tie 

breaker used is something known as preference that is configured under the dial-peer. The lower the 

preference, the higher the priority of that dial-peer getting chosen.  

 

In the below example, let us assume that a customer has a primary route of the SIP trunk for long 

distance calls, in the event that the SIP trunk is down, they want to route calls over a backup analog 

line on FXO port 0/1/0.  

 
dial-peer voice 5001 voip 
  description SIP Trunk dial-peer for Long Distance 
  destination-pattern 91[2-9]..[2-9]……  
  session protocol sipv2  
  codec g711ulaw   
  session target dns:sipconnect.cisco.com 
  no vad 
  dtmf-relay rtp-nte 
! 
dial-peer voice 5000 pots 
  description Backup FXO dial-peer for Long Distance 
  destination-pattern 91[2-9]..[2-9]……  
  preference 5 
  port 0/1/0 
! 
 

The default preference is “0” (default CLIs will NOT show up in the config) and hence the primary 

route chosen is the SIP trunk dial-peer versus the FXO dial peer. 

 
Class of Restrictions (COR) 

COR provides a way to deny certain calls based upon the incoming and outgoing settings on dial 

peers and ephone-dns. Each dial peer and ephone-dn can have one incoming COR and one outgoing 

COR. 

The incoming COR list indicates the capacity of the dial peer to initiate certain classes of calls. 

The outgoing COR list indicates the capacity required for an incoming dial peer to deliver a call via 

this outgoing dial peer. 

 



 

dial-peer cor custom 
 name internal 
 name local 
 name domestic 
 name international 
! 
dial-peer cor list call-domestic 
 member domestic 
! 
dial-peer cor list user-domestic 
 member internal 
 member local 
 member domestic 
! 
dial-peer voice 5003 pots 
 corlist outgoing call-domestic 
 description ** FXO pots dial-peer ** 
 destination-pattern 91............. 
 port 0/1/0 
! 
ephone-dn  11  dual-line 
 number 102   
 corlist incoming user-domestic 
 
Reference for further information: 

http://www.cisco.com/en/US/tech/tk652/tk90/technologies_configuration_example09186a008019d6

49.shtml  

 

Using Translation rules 

Incoming  

COR List 

Outgoing  

COR List 

Outgoing Dial-peer 

PSTN 

Call Allowed: Member domestic Matches 
for Incoming and Outgoing COR List 

Call Blocked: No Member Match for 
Incoming and Outgoing COR List 

BLOCK 

Incoming 

Ephone-dn 

eepphhoonnee--ddnn  1111  

  nnuummbbeerr  110022  

  ccoorr  iinnccoommiinngg  uusseerr--

ddoommeessttiicc  

ddiiaall--ppeeeerr  ccoorr  lliisstt  uusseerr--

ddoommeessttiicc  

  mmeemmbbeerr  iinntteerrnnaall  

  mmeemmbbeerr  llooccaall  

  mmeemmbbeerr  ddoommeessttiicc  

DDiiaall--ppeeeerr  ccoorr  lliisstt  

ccaallll--ddoommeessttiicc  

  mmeemmbbeerr  ddoommeessttiicc  

ddiiaall--ppeeeerr  5533  vvooiiccee  ppoottss  

  ccoorrlliisstt  oouuttggooiinngg  ccaallll--

ddoommeessttiicc  

  ddeessttiinnaattiioonn--ppaatttteerrnn  

9911..........................  

  ppoorrtt  00//11//00  

DDiiaall--ppeeeerr  ccoorr  lliisstt    

ccaallll--iinntteerrnnaattoonnaall  

  mmeemmbbeerr  iinntteerrnnaattiioonnaall  

http://www.cisco.com/en/US/tech/tk652/tk90/technologies_configuration_example09186a008019d649.shtml
http://www.cisco.com/en/US/tech/tk652/tk90/technologies_configuration_example09186a008019d649.shtml


 
The UC500 allows for digit manipulation via a feature known as Voice Translation rules. The digit 

manipulation can be applied to called numbers or calling numbers (caller ID) and can be applied 

when the call is received or sent out to another destination by the UC500. For example, in Lab 6 

during the inter site dial-plan an example was shown on how to setup inter site dialing with 5 digits 

– on each UC500 digit translation was done translate the called number from 5 digits to the 3 digit 

extension local to the UC500. The translation rules are typically applied on the basis of matching a 

given digit string and then manipulating that. This digit string & manipulation uses wildcard 

matching via regular expressions.  

 

In the below example – the intent is to manipulate all caller ID going out the SIP trunk to match the 

main number (eg 408 555 1200): 

 

Step 1:  Define the match pattern and digits that this should be manipulated to: 

voice translation-rule 10001 

  rule 1 /^.*/ /4085551200/ 

 

Step 2:  Define what is being manipulated (meaning called or calling number) 

voice translation-profile PSTN_OUTBOUND_CID 

translate calling 10001 

 

Step 3:  Apply the profile to the outbound dial-peer in this case – it‟s the SIP Trunk dial-peer: 

dial-peer voice 5001 voip 

  translation-profile outgoing PSTN_OUTBOUND_CID 

 

Another example would be converting the main number to the internal AA extension. In this 

example the inbound call comes in on a T1 PRI trunk as 4085551200 and the internal AA is 400 

 

Step 1:  Define the match pattern and digits that this should be manipulated to: 

 voice translation-rule 10002 

   rule 1 /4085551200/ /400/ 

 

Step 2:  Define what is being manipulated (meaning called or calling number) 

voice translation-profile AA_CALLED_NUMBER 

 translate called 10002 

 

Step 3:  Apply the profile to the inbound dial-peer in this case – it‟s the POTS dial-peer: 

dial-peer voice 5100 pots 

 incoming called-number 4085551200 

 translation-profile incoming AA_CALLED_NUMBER 

 direct-inward-dial 

 

More complex examples are at: 

http://www.cisco.com/en/US/tech/tk652/tk90/technologies_tech_note09186a0080325e8e.shtml

http://www.cisco.com/en/US/tech/tk652/tk90/technologies_tech_note09186a0080325e8e.shtml


 

APPENDIX H: Designing for a Scenario 
 
In this lab, use the voice features that you have learned so far to fulfill the following customer‟s 

scenario.  

 

Two employees on the system have primary extension 201 and 202. The operator has a primary 

extension 203. Make sure she can view the status of phones 201 and 202 as she may be required to 

transfer some calls to these employees‟ primary extension. In addition to the primary extensions, 

the employees have extensions 251, 252 and 253. 

 

Extensions 201 and 202 are part of Sales department and extensions 251 and 252 are part of the 

marketing department. 

 

The customer has FXO lines as well SIP trunks for PSTN access. For outbound calls, make sure to 

use the SIP trunk as the first choice, if the SIP trunk is down the calls should fallback to the analog 

FXO lines. 

 

Incoming calls to FXO ports 0/1/0 and 0/1/1 should go directly to the Auto Attendant (AA). Use the 

prompt management system to record the AA greeting. The AA greeting should prompt caller to: 

o Enter 1 for “Employee A” and 2 for “Employee B”.  

o For Sales department, the caller should be prompted to enter option 3. Unanswered calls to 

the sales department should be forwarded to the voicemail.  

o For Marketing department, the caller should be prompted to enter option 4. Unanswered calls 

to the marketing department should be forwarded to the operator at extension 253. 

o To be transferred to TAC helpline,  the caller should be asked to enter option 5.  

o Also if the caller has a mailbox on the system, he should be able to dial 9 to login and check 

his messages. 

o Finally he should be able to dial 0 to reach the operator at extension 203. 

 

Incoming calls to FXO ports 0/1/2 and 0/1/3 should ring all phones, and if there is no answer, then it 

should be forwarded to the AA. 

 

There are DID numbers available from the SIP trunk provider. Incoming DIDs 4085xx1201 to 

4085xx1203 should be mapped to the users‟ extension. All other DIDs should be forwarded to the 

AA. 

 

A local directory should include contacts for TAC helpline at 800-553-2447 and PDI helpline at 800-

462-4726. Users should be able to search and dial these numbers (configure appropriate prefixes). 

Users should use CME web GUI to configure their own speeddials. 

 

BONUS SCENARIO: 

Unanswered calls to sales department should hear a message “All our agents are busy, to continue 

to hold press 1, or press 0 to leave a message” 



 

APPENDIX I: Device Manager Cross Launch 
 
Introduction: 

Many devices in the Cisco SBCS portfolio have embedded device managers which can be accessed from 

a web browser such as Microsoft Internet Explorer. 

 

CCA can automatically launch the embedded device manager of a Cisco SBCS platform as long as the 

device can be discovered in the CCA network topology view and the CCA PC has network connectivity to 

the discovered device. This feature is called device manager cross launch.  

 

Objective: 

Using CCA, cross Launch the device manager for a switch connected to the UC500 

 

Lab Set-up: 

Refer to the main diagram. Connect a Cisco CE520 to the UC500 expansion port. 

 

Device manager cross launch requires that a default web browser is configured on the PC that has CCA 

installed. While in most cases this should already be configured, the steps below outline how to set this 

up for common web browser software. 

 

Microsoft Internet Explorer 6.0 

Select Tools > Internet Options. Select “Internet Explorer should check to see whether it is the default 

browser” and click OK.  

 

 
Microsoft Internet Explorer 6.0 

Select Tools > Internet Options > Programs tab. Select “Internet Explorer should check to see whether 

it is the default browser” and click OK 

 



 

 
 

Mozilla Firefox 3.0 

Select Tools > Internet Options. Click Check Now. Click yes at prompt to make Firefox the default  

 

 
 

Setup Steps: 

 

Step 1:  Launch CCA, connect directly to the IP address of the UC500 (192.168.10.1) and enter the 

username and password (cisco/cisco.) Let CCA discover the network and connected devices. 

 



 

 
 

Step 2:  Check the topology to ensure the CE520 appears.  

 

Step 3:  Right click the switch icon in the Topology View window and select Device Manager.  

 

 
 

You can also right click the switch icon under the Neighbors table and select Device Manager.  

 

 
 



 
Step 4:  The default web browser on your PC will automatically launch, with the URL pointing to the IP 

address of the switch. In the example below, the CE520 IP address is 192.168.10.11, hence the device 

manager cross launches with an URL of http://192.168.10.11 

 

 


